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GOFW2008 License Agreement 

 

The license agreement given below is the normal license agreement for GOFW2008.  It can be 
noted according to condition number 11 that “This agreement constitutes the sole understanding 
between the parties concerning GOFW2008 and may only be modified in writing agreed to by all 
parties.”  If your company has agreed to a modified license agreement, a record of this modified 
license agreement should reside in your company‟s records. 
 
This Agreement is by and between: 
 
Starling Associates, Inc. 1324 Brookside Drive, Norman OK 73072, U.S.A. (hereinafter referred to 
as “DEVELOPER”) and Licensee (hereinafter referred to as “USER”) for the use of a certain 
proprietary computer software product known as GOFW2008 and its related documentation (herein 
referred to as “MANUALS”) which together have been developed by DEVELOPER. 
 
DEVELOPER grants to USER a non-exclusive license to use GOFW2008 solely by USER or 
USER company personnel and solely using USER or USER company owned Windows-based 
personal computers.  Use of GOFW2008 by any person other than USER or USER company 
personnel is prohibited.  Installation of software using GOFW2008 on any computer not owned by 
the USER or USER company is prohibited.  Installation of software using GOFW2008 on any 
intranet or internet server is prohibited.  The following conditions also apply. 
 
1. License Fee. USER must pay the current license fee. 
 
2. Activation. USER must activate the software only on the number of computers for which the 
license fee has been paid (Windows based personal computers).  For each installed computer, USER 
must supply a file containing GOFW2008 security information, so DEVELOPER can supply a 
GOFW2008 license file for each installed computer.  Any change in this activation process must be 
agreed between USER and DEVELOPER. 
 
3. Support Service. DEVELOPER will provide one instance per installed computer, up to a 
maximum of ten instances per licensee, of reactivation or e-mail support service during the first year 
of this license agreement. Additional support will be billed at then current rates.  Support service 
involving issues specific to computer operating systems (e.g., Microsoft Windows 7) and/or 
Microsoft Office software (e.g., Excel 2007) and/or other software or systems which affect the use 
of GOFW2008 will be billed at current rates at the time of service.   
 
4. Copyright. USER will abide by the Copyright laws with respect to GOFW2008. USER may copy 
MANUALS for use by USER and/or USER company employees. Selling or distributing this 
software or executable programs (including intranet or internet applications) using this software 
without written permission from Starling Associates, Inc. is prohibited. 
 
5. Disclaimer. GOFW2008 and the information contained therein are provided “as is.” 
DEVELOPER and any agent , representative, publisher, or distributor of GOFW2008, or any of 
their respective directors, officers, employees, agents, representatives or members make no 
guarantee or warranty of any kind, either express or implied, including, but not limited to warranties 
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of merchantability or fitness for any particular use or any other warranties implied by law and USER 
specifically releases all such Developer and all such person from any such warranties and 
representations.  
 
6. INDEMNIFICATION 
Starling Associates, and any agent, representative, publisher or distributor of GOFW2008, or any of 
their respective directors, officers, employees, agents, representatives or members (the "Indemnified 
Parties") shall have no liability for, and User shall defend, indemnify and hold each of the 
Indemnified Parties harmless from and against any judgment, liability, loss, cost or damage 
(including any settlement amount, litigation costs, reasonable attorneys' fees, and other legal 
expenses) incurred as a result of any suit, action, or claim arising out of, pertaining to, or resulting in 
any way from, the use or possession of, or information contained in GOFW2008 by User and/or 
any of its users directors, officers, employees, representatives, agents or contractors. 
 
7. LIMITATIONS OF LIABILITY 
 
A. User acknowledges that each of the Indemnified Parties' obligations and liabilities with respect to 
GOFW2008 are exhaustively defined in this Agreement. NONE OF THE INDEMNIFIED 
PARTIES NOR ANY OF ITS DIRECTORS, OFFICERS, EMPLOYEES, AGENTS, 
REPRESENTATIVES, OR MEMBERS SHALL BE LIABLE TO USER, WHETHER UNDER 
CONTRACT, TORT (INCLUDING NEGLIGENCE) OR OTHERWISE, FOR ANY LOSS OF 
PROFITS, LOSS OF BUSINESS, INTERRUPTION OF BUSINESS OR INDIRECT, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY KIND RESULTING FROM 
ANY BREACH OF ITS AGREEMENT OR FROM ANY USE OF GOFW2008, EVEN IF THE 
DAMAGED PARTY HAS ADVISED THE OTHER PARTY OF THE POSSIBILITY OF 
SUCH LOSS. WITHOUT LIMITING THE FOREGOING, THE INDEMNIFIED PARTIES' 
AGGREGATE LIABILITY TO USER SHALL BE LIMITED TO THE AMOUNT RECEIVED 
BY DISTRIBUTOR FROM USER HEREUNDER. 
 
B. If at any time an allegation of infringement of any rights of any third party is made, or in the 
Indemnified Parties' opinion is likely to be made, with respect to GOFW2008, Distributor may, at 
its option and at its own expense (i) obtain for User the right to continue using GOFW2008, (ii) 
modify or replace GOFW2008 or any portion thereof so as to avoid any such claim of infringement, 
or (iii) refund to User the License Fee. The Indemnified Parties shall have no liability to User if any 
claim of infringement would have been avoided except for users refusal to use any modified or 
replacement GOFW2008 supplied or offered to be supplied pursuant to this Section 7(b) or to 
otherwise cease using GOFW2008. 
 
C. Section 7(b) states the entire liability of the Indemnified Parties with respect to the infringement 
or alleged infringement of any third party rights of any kind whatsoever by any of GOFW2008.  
 
8. Effective Date and Termination. 
 
a. This Agreement shall become effective on the date of license fee purchase by USER. 
b. For a three year license, the GOFW2008 license will continue from the date of purchase of 
license fee by the USER for three years. 
c. For a longer-term license, the GOFW2008 license will continue from the date of purchase of 
license fee by the USER for the agreed period of the longer-term license.  
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9. GOVERNING LAW.  This Agreement shall be governed and construed in accordance with the 
laws of the United States and with the laws of the state of Oklahoma applicable to contracts entered 
into and to be performed entirely therein without regard to any choice or law or conflict of law 
provisions. 
 
10. DISPUTE RESOLUTION. In the event of a dispute arising from or relating to this Agreement, 
each Party shall appoint a senior management representative to negotiate a resolution. If such 
efforts are not successful within thirty (30) days or as otherwise agreed by the Parties, then the 
Parties may submit any dispute arising from or related to this Agreement to non-binding mediation 
in a neutral location mutually agreeable to the Parties. If the Parties cannot agree on a neutral 
location within thirty (30) days, then the mediation shall be in Norman,Oklahoma. If such mediation 
is not chosen or is not successful, then the Parties shall submit the dispute to arbitration by a single 
arbitrator in accordance with the Rules for Commercial Arbitration of the American Arbitration 
Association in a neutral location mutually agreeable to the parties. If the Parties cannot agree on a 
neutral location within thirty (30) days, then the arbitration shall be in Norman, Oklahoma. The 
arbitrator shall have the power to award damages, costs and attorneys‟ fees in his/her discretion and 
subject to the principles of equity. 
 
11. Miscellaneous.  
- This agreement constitutes the sole understanding between the parties concerning GOFW2008 
and may only be modified in writing agreed to by all parties. 
- Any obligations and duties which by their nature extend beyond the expiration or termination of 
this Agreement shall survive the expiration or termination of this Agreement. 
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Disclaimer, Copy and Copyright Notice 

Nothing contained in this user's guide or the GOFW2008 program is to be construed as granting any 
right, by implication or otherwise, for the manufacture, sale, or use in connection with any method, 
apparatus, or product covered by letters patent, nor as insuring anyone against liability for infringement of 
letters patent. 

Every effort has been made to assure the accuracy and reliability of the data contained herein; however, 
Starling Associates, Inc. makes no representation, warranty, or guarantee in connection with this program 
and hereby expressly disclaims any liability or responsibility for loss or damage resulting from their use; 
for any violation of any federal, state, or municipal regulation with which this program may conflict; or for 
the infringement of any patent resulting from its use. 

This software product and computer code are copyrighted and all rights reserved by Starling Associates, 
Inc.  The license for this software is intended only for the use of the original purchaser.  The original 
purchaser is expressly prohibited by Starling Associates, Inc. from providing a copy or copies of 
GOFW2008 (or any of the associated files) to any other person or persons.  Selling or otherwise 
distributing this program without written permission from Starling Associates, Inc. is prohibited. 

 

The GOFW2008 V1.0, Release 1.0 Manual 
 July 31, 2008 

Visit our web site: www.starlingassoc.com 

http://www.starlingassoc.com/
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GOFW2008 Product Support  

Starling Associates Inc. is committed to providing the best possible technical support for GOFW2008 
and all our products. Please follow the procedure outlined below. 

The Starling Associates web site is the fastest and most efficient way to locate information about our 
products including maintenance files and contact information. The web site is available 24 hours a day 
and allows you to send your questions, comments and suggestions by e-mail to sai@starlingassoc.com.  

Technical Support 

When requesting technical support, please provide the following information: 

 Your name and the name of the registered user, if different. 

 Address, phone and fax number, and email address, if available. 

 System information of the computer you are using including the operating system, the amount of 
memory and system resources and any relevant devices or peripherals. 

 A detailed description of the problem.  Describe error messages exactly as they appear.  List the steps 
and conditions that led to the problem. 

Contacting Starling Associates, Inc 

 
Starling Associates website http://www.starlingassoc.com 

E-mail sai@starlingassoc.com 

 

 

Activating the License for GOFW2008 

 

Click the GOFW2008 License Manager in the Starling Associates GOFW2008 License Manager folder 
on the Start Menu and save the .c2v file on your PC with a name of your choice. Send this file to 
sai@starlingassoc.com. A file with the extension .v2c will be returned to you; you can check it in using the 
GOFW2008 License Manager and your 3 year license will be activated.

 

mailto:sai@starlingassoc.com
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Chapter 1 

Introduction 

Congratulations on licensing GOFW2008. Discover how easy it is to perform flow calculations and 
to evaluate the economic impact of using different standards to measure natural gas flow. 

Installation 

 

System Requirements 

Please check that the system on which you will be installing GOFW2008 meets these requirements: 

 IBM compatible PC with a 486 or higher microprocessor 

 Minimum 8 MB RAM 

 Microsoft Windows Version 2000, XP or Vista. 

 Hard disk space requirement: 60 MB (+ 24 MB for Acrobat reader). 

Installing GOFW2008 

If your installation is from a setup executable program, merely follow the instructions provided.  If 
your installation is from a CD-ROM follow the instructions below. 
Start Windows and close all open applications 

 Insert the supplied diskettes/CD-ROM 

 Click the Start button on the Windows taskbar. 

 Point to Settings and click on Control Panel.  In the Control Panel window, click on the 
Add/Remove Programs icon. 

 Follow the instructions on the screen. 

I C O N  K E Y  

 Valuable information 

 Steps 

 Contents 
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Check List 

After installation you should have the following items installed in C:\Starling Associates GOFW2008\. 

 GOFW2008 program files 

 GOFW2008 MANUAL.PDF 

 Example-As Found.CS1 

 GOFW2008.INI 

 LICENSE 

 GOFW2008 License Manager 

Manual File 

The file GOFW2008 MANUAL.PDF is a copy of the GOFW2008 User Manual.  It is installed during 
GOFW2008 installation.  If the Adobe Acrobat reader is installed on the user computer, the manual may 
be viewed by clicking “GOFW2008 Manual” in the GOFW2008 folder on the Start taskbar. The Adobe 
Acrobat reader software also is available on the Internet.  Note that the “Find” option in the “Edit” menu 
available with Adobe Acrobat provides the user with an effective tool for searching the GOFW2008 
Manual for specific topics of interest.  Also, viewing the index of the GOFW2008 Manual can be 
helpful in locating numerous topics.  

Running GOFW2008 

 

 In Windows, click on the Start button and choose All Programs.  Select Starling Associates 
GOFW2008 and click on the GOFW2008 icon. 

 The GOFW2008 welcome screen appears while program initialization is taking place. 

 You have successfully launched GOFW2008. 

User Interface 

Although many terms in this manual are familiar to Windows users, two terms relate specifically to the 
format of the GOFW2008 program.  These are the GOFW2008 Notebook and the GOFW2008 Tabs. 

The GOFW2008 interface is presented in an easy-to-use format referred to as the GOFW2008 
Notebook (shown below).  Accessing various parts of GOFW2008 requires a simple click on a Tab of 
the Notebook.  Chapters 4 though 8 contain detailed descriptions of the GOFW2008 Configuration Tabs 
found on the right side of the Notebook.  The GOFW2008 Selection Tabs (found on the left side of the 
Notebook) are used to specify the As Found and As Left conditions.  The Compare Selection Tab shows 
a comparison of those conditions. 
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GOFW2008 Notebook  

             Selection Tabs                                                  Configuration Tabs 

 

The other parts of the GOFW2008 screen follow the familiar Windows format.  They are explained 
below. 

The Titlebar  

The titlebar shows the software name, Starling Associates, Inc. GOFW2008. 

The Meter Titlebar  

The Meter Titlebar displays the meter‟s name. 

The Menu Bar 

The GOFW2008 Menu Bar is always visible within GOFW2008. It contains the following drop-down 
menus: 

 The File menu contains New Meter, Open, Save As, Save, Close, Print Setup and Exit 

 The Edit menu contains Cut, Copy, Paste, Delete, AF-AL/AL-AF 



S T A R L I N G  A S S O C I A T E S ,  I N C .  

 

 5 

 The Calculation Type menu contains Volume Flow Rate, Mass Flow Rate, Differential Pressure, 
Orifice Size 

 The View menu contains As Found, As Left, Comparison, Meter Properties, Toolbar, Statusbar 

 The Generate menu contains As Found Report, As Left Report and Comparison Report 

 The Window menu contains Unit Converter and all active windows in GOFW2008 

 The Help menu contains Help Topics and About GOFW2008 

The Toolbar 

Many essential GOFW2008 Tools are included on the toolbar located at the top of the GOFW2008 
Notebook.  

 The toolbar can be toggled on and off on the View menu 

Button Name Function 

 
New meter Opens a New Meter for a new calculation, comparison, etc. 

 
Open Opens an existing GOFW2008 file 

 
Save Saves your GOFW2008 file under its current name and location with the 

default .CS1 extension 

 
Cut Cuts the selected text and places it on the clipboard 

 
Copy Copies the selected text and places it on the clipboard 

 
Paste Pastes the text from the clipboard at the point where the cursor is located  

 
AF-AL/ 
AL-AF 

If the As Found Selection Tab is selected when this tool button is clicked, the 
configuration in the As Found Tab is copied to the As Left Tab. If the As 
Left Tab is selected when this tool button is clicked, the configuration in the 
As Left Tab is copied to the As Found Tab (note that this operation also 
occurs with the AF-AL/AL-AF selection on the Edit drop-down menu on 
the GOFW2008 Menu Bar.  

 
AF Opens the As Found report 

 
AL Opens the As Left report 

 
CO Opens the Comparison report 
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FC Opens the Units Converter 

Meter Properties 

Meter Properties is the first GOFW2008 screen encountered after program initialization. Meter Properties 
also can be accessed from the drop-down menu under View on the GOFW2008 menu bar. Meter 
Properties allows the user to record information pertinent to the meter.  There are two Tabs in Meter 
Properties which are used to identify the meter: 

General  

In the General Tab, the user identifies the meter for which a calculation is being performed. 

 

Identification fields on the General Tab are: 

 Meter #. 

 Field. 

 Well. 

 Lease. 

 Meter Tag 

Only Meter # must be specified in order to continue. The other fields are optional identifiers.  When the 
OK button is clicked, the entry in the Meter # field will be shown at the top of the GOFW2008 
Notebook. 
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Saved 

The Saved Tab shows the time at which the configurations for the meter As Found and As Left came 
into effect. The default for the Date and Time for both the As Found and As Left conditions is the time 
at which the new GOFW2008 file was opened. The user may change those times for proper reporting 
and record. 

 

GOFW2008 Help 

GOFW2008 features a full-function online reference. 

Information in GOFW2008 can be easily located with any of the following methods: 

 Clicking on highlighted text in the Contents window displays a discussion about the item of interest. 

 Clicking the Search button located on the toolbar displays an alphabetical list of GOFW2008 topic 
titles. You can select a topic from the list or search for an entry by entering a word in the search field. 

 Within Help, you can access any topic highlighted in green by clicking on the text including: 

 The location of GOFW2008 variables in the reference standards and their use in GOFW2008.  These 
can be accessed from the first screen in Help (Variables Description). 

 A description of error and warning messages used in GOFW2008.  These are available by placing the 
cursor on the Error Indicator field of the Meter Data Configuration Tab and pressing F1.  
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 The list of outputs generated by GOFW2008.  These can be accessed from the opening Help screen 
by choosing Variables Description, then Output Variables, then Outputs.  

Unit Converter 

The unit converter is a useful feature for conversions of many different types of units. The results can be 
copied and pasted into the GOFW2008 Notebook. To access Unit Converter, choose Unit Converter on 
the Window menu of the GOFW2008 menu bar. 

To perform a conversion, follow these steps: 

  Click within the Conversion Type box to choose the unit conversion desired 

 Click within the Unit In box to choose the unit of the quantity to be converted 

 Click within the Unit Out box to choose the desired units of the quantity being converted. 

 Enter the quantity to be converted in the Value In box and click the Calculate button. 

A conversion is made each time you choose a Unit In or a Unit Out. However, if the Value In changes 
and the Unit In and Unit Out remain the same, you must use the Calculate button to obtain the desired 
conversion. 

 After highlighting the Converted Value, a click on the right mouse button opens a menu allowing 
cut/paste, copy/paste, and delete operations on the fly.  Note that the Edit menu on the GOFW2008 
Menu Bar also can be used for delete, cut/paste, and copy/paste operations. 

 

Generating a Report 

Three reports can be generated with GOFW2008:  

 An As Found Report 
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 An As Left Report 

 A Comparison Report 

The Comparison Report contains the information in the As Found Report and the As Left Report plus 
additional information about the absolute and percent differences between the As Found and As Left 
Conditions (As Left-As Found). GOFW2008 uses Crystal Reports technology to generate reports. 
Information in the reports is written into a database that is replaced each time a report is generated. These 
reports are not attached to GOFW2008 executable. They are independent files which can be customized 
if the user owns the Crystal Reports 7.0 software. For  information about Crystal Reports, contact Seagate 
Software at 732-321-6500. The reports included allow the user to perform the following functions: 

 Choose among three different screen displays. 

 Export the report to most popular formats and save it to a disk or mail it via MAPI. 

 Print the report. 
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CHAPTER 2 

A Quick Tutorial 

he GOFW2008 program allows the user to compare the volumetric flow rate in the As Left 
condition with the As Found condition as, for example, following meter calibration.  In this 
tutorial, we will use GOFW2008 to find the difference in flow rate after a calibration of the 
differential pressure gage.  The technician equipped with a laptop and the GOFW2008 software 

will be able to immediately calculate the difference in flow rate (and other quantities) and print or email a 
detailed report reflecting the calibration.   

The tutorial in this chapter was designed to familiarize users with the major features of GOFW2008.  
Follow along with steps below: 

 Launch GOFW2008 by clicking on the Windows Start button and selecting All Programs.   Select 
Starling Associates GOFW2008 and click on the GOFW2008 icon. 

 Click the OK button on the Meter Properties screen. The GOFW2008 Notebook opens with the 
default configuration (see Chapter 7 for information on changing the default configuration). 

 

T 
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The As Found and As Left Conditions are the same. The default configuration is: 

 Flow Rate Standard: AGA3 1992 

 Super Compressibility: AGA8 1992 

 Gas Characterization: Gas Analysis 

 System of Units: US 

Next, open the following file provided with GOFW2008: Example-As Found.CS1 

 Click on the Open button and select the file Example-As Found.CS1 from the Open screen. 

 

The GOFW2008 Notebook will display the Meter Properties screen, with the entries CALIBRATION, 
GULF COAST GAS, COMPOSITION, AGA 8 1992, PAGE 74 (note that the calculated 
compressibility factor can be verified by comparison with the AGA8 1992 standard for this composition). 

 Click the OK button on the Meter Properties screen.  The GOFW2008 Notebook will display the 
input values for the meter in Example-As Found.CS1, in the As Found condition (before 
calibration). 

 Click on the Configuration Tabs to view the As Found input values.  The As Found conditions in 
Example-As Found.CS1 correspond to the meter conditions “as found” before meter calibration was 
performed.  The As Found conditions have been copied into the As Left conditions in Example-As 
Found.CS1 so that this tutorial can correspond to an example of calibration of a meter. 

 Click on the As Left tab to see that Example-As Found.CS1 initially has the same meter conditions 
for As Left and for As Found. 



S T A R L I N G  A S S O C I A T E S ,  I N C .  

 

 13 

The Compare tab shows a comparison of the As Left and As Found values for certain quantities, 
including Meter Data, Hardware and Gas Flow Rate. 

 Click on the Compare tab to see this comparison (the differences between As Left and As Found 
initially are zero). 

After meter calibration, the meter may be left in a configuration which results in a calculated gas flow 
rate (As Left) which differs from values calculated before the calibration (As Found).  Consider an 
example for which the calibration of the differential pressure gage results in hw (As Left) = 50.5 
inches of water, compared to hw (As Found) = 50.0 inches of water. 

Change the Differential Pressure, hw for the As Left condition from 50.0 to 50.5. 

 Click on the Compare tab to view the effect of this calibration of the differential pressure gage. 

 

Notice on the Compare screen that the increase in Differential Pressure hw from 50.0 to 50.5 inches 
of water yields an increase in the calculated Gas Flow Rate from 3.897 to 3.917 MMscfd.  The Gas 
Analysis used (viewed by clicking the Gas Char tab) yields a calculated Gross HV = 1036.04 Btu/scf 
(viewed by clicking the meter Data tab then clicking the “dog ear” on that page to reveal the second 



G O F W 2 0 0 8 V 1 . 0  

 

 14 

page of the Meter Data section of the Notebook).  On the Compare report a Gas Value of 7.55 
US$/MMBtu has been used resulting in a gas value increase from $30,484 to $30,636 per Day. 

The Compare Tab shows only a summary of the differences between the As Left and As Found 
conditions.  GOFW2008 also prepares reports with detailed information on inputs and calculated 
outputs.  Click on Generate on the GOFW2008 menu bar to view the drop-down menu which 
allows the report options As Found Report, As Left Report and Comparison Report (the Toolbar 
options AF, AL and CO also provide these report options). 

 Next, generate a Comparison Report. Simply choose Comparison Report from the Generate menu 
(or click on the CO button on the toolbar). 

 

 Click on the Maximize button to have a full screen for the report window 

 Click on the Print button  to print the report 
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 Click on the Export button  to export the report in numerous different ways, including as a 
Crystal Reports file, an Excel file, a Microsoft Word document, and a file for email via MAPI. 

 Return now to the computer monitor display and perform the following steps to save the As Left 
configuration in a GOFW2008 file named Example-As Left.CS1.  First, click the As Left tab.  Next, 
access the drop-down menu under Edit on the GOFW2008 menu bar and click on AF-AL/AL-AF.  
This step moves all of the As Left input variable values into the As Found input text boxes, causing 
the As Found information to be the same as the As Left information.  Next, access the drop-down 
menu under View on the GOFW2008 menu bar and click on Meter Properties.  In the Meter# 
textbox, type Example-As Left and click the OK button.  Then, access the drop-down menu under 
File on the GOFW2008 menu bar and click on Save As.  In the File name dialog box type Example-
As Left, then click the Save button, which saves the GOFW2008 file named Example-As Left.CS1. 

 Note that the As Found information still is in the original GOFW2008 file named Example-As 
Found.CS1 and the As Left information is in the newly created GOFW2008 file named Example-As 
Left.CS1. The next section provides a more general discussion GOFW2008 file handling.       

 

Creating, Saving and Reopening GOFW2008 Input Files 

  
When GOFW2008 is started, a set of default values appear on the GOFW2008 window. 
GOFW2008 uses the file GOFW2008.ini for this initial default configuration. The file 
GOFW2008.ini is placed in the subdirectory in which the GOFW2008 software is installed. 
  
The first screen which appears when GOFW2008 is started up has a form on the left hand side 
titled Meter Properties. The Meter# box is already filled in with “SAI”, which comes from the 
initialization file GOFW2008.ini. Clicking OK in the Meter Properties form places “Meter – SAI” 
on the banner of the next window which appears. 
  
A new input file can be created by modifying the entries in the boxes in the GOFW2008 windows. 
Accessing the drop-down menu under View on the GOFW2008 menu bar and clicking on Meter 
Properties allows changing the Meter# from “SAI” to a Meter# corresponding to the newly created 
calculation. Then accessing the drop-down menu under File on the GOFW2008 menu bar and 
clicking on Save As allows entering a file name for the newly created input file. 
  
Similarly, another input file can be created by modifying the entries in the boxes in the GOFW2008 
windows, changing the Meter# and saving the input file with an appropriate name. Then to reopen an 
input file which was created earlier, access the drop-down menu under File on the GOFW2008 menu bar 
and click on Open. You will be asked if you wish to save the information for the current meter before 
opening a new meter. It is best if you have saved the current information previously so you can click No. 
If you click No, you will immediately be allowed to reopen any previously saved GOFW2008 input file. 
When this meter reopens, be sure to click OK on the Meter Properties screen to preserve the Meter# 
associated with the meter calculation.  

To insure that you know whether a GOFW2008 .CS1 file contains As Found information or As Left 
information, it is recommended that the As Left information be moved into the As Found input 
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textboxes and that the file be saved using an easily identified file name.  The procedure is (1) click the As 
Left tab, (2) access the drop-down menu under Edit on the GOFW2008 menu bar and click on AF-
AL/AL-AF, (3) access the drop-down menu under View on the GOFW2008 menu bar and click on 
Meter Properties, (4) in the Meter# textbox, type text identifying the meter information as being in the As 
Left description and click the OK button, (5) access the drop-down menu under File on the GOFW2008 
menu bar and click on Save As, (6) in the File name dialog box type the desired file name, then click the 
Save button, which saves the GOFW2008 file with extension .CS1.  An easy way to be reminded of what 
the configuration is for a GOFW2008 input (.CS1) file is to use the same file name as the Meter# textbox 
entry (as was done in the previous section for Example-As Found.CS1 and Example-As Left.CS1). 



S T A R L I N G  A S S O C I A T E S ,  I N C .  

 

 17 

CHAPTER 3 

GOFW2008 Standards and Calculation Types  

OFW2008 is a powerful analysis and calculation tool.  It allows the user to compare the 
volumetric flow rate in the As Left condition with the As Found condition following meter 
calibration.  In a similar manner, it can be used to compare the use of different measurement 
standards.  In addition to the volumetric flow rate, GOFW2008 can be used to calculate 

mass flow rates, to size an orifice plate or to estimate the pressure drop for a particular system. This 
chapter will discuss the standards and calculations available in GOFW2008. 

Standards Covered  

The flow rate standard used in a GOFW2008 calculation is selected on the left side of the Notebook.  

The choices for Flow Rate Standard () and associated Super Compressibility (z) include: 

 AGA 3 1992 (default) 

z AGA 8 1992 (default) 

z User Input 

 AGA 3 1985 

z AGA 8 1985 

z AGA 8 1995 (Alternate Method) 

z NX19 1962 

z User Input 

 AGA 7 - AGA 9 - Linear Meters AGA 8 1992 

z AGA 8 1992/GPA 2172-96 

z AGA 8 1985 

z AGA 8 1995 (Alternate Method) 

G 
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z NX19 1962 

z User Input 

 

Technical documentation for calculations using default Flow Rate Standard AGA3 1992 and 
Supercompressibility AGA8 1992 in the GOFW2008 computer program appears in the most recent 
versions of AGA Reports No. 3 (1992) Orifice Metering of Natural Gas and Other Related 
Hydrocarbon Gases and No. 8 (1994 Reprint) Compressibility Factors of Natural Gas and Other 
Related Hydrocarbon Gases and Chapter 14 of the American Petroleum Institute (API) Manual of 
Petroleum Measurement Standards.  It should be noted that Section 2 of Chapter 14 of API MPMS is 
equivalent to AGA Report No. 8.  It should also be noted that the following are equivalent documents: 
(1) Section 3 of Chapter 14 of API MPMS, (2) AGA Report No. 3, (3) GPA 8185, (4) API 2530 and 
(5) ANSI/API 2530. Note that although AGA Report No. 8 is referred to as AGA8 1992 in 
GOFW2008, all calculations are performed according to the most recent version (1994 reprint).  

For the other possible standards in GOFW2008 the technical documentation appears in the 1985 version 
of AGA. Report No. 3, the 1985 version of AGA. Report No. 8, the 1962 version of the NX-19 Report, 
the 1986 version of GPA. 2172, the Measurement of Gas by Turbine Meters, Transmission  
Measurement Committee Report No. 7,  Second Revision, April 1996, and  Measurement of Gas by 
Multipath Ultrasonic Meters, Transmission Measurement Report No. 9, June 1998. 

The combinations of standards supported by GOFW2008 are illustrated in the table below: 

Flow Rate Standard Super Compressibility Gas Characterization (GOFW2008 Syntax) Standard Name 
AGA3 1992, AGA8 1992 Gas Analysis Detail Method 
AGA7, AGA9,  
LINEAR 

 HV-GR-CO2 Gross Characterization Method 1 

METERS  GR-CO2-N2 Gross Characterization Method 2 
 AGA8 1992/ 

GPA2172 96 
Gas Analysis Detail Method 

 User Input User Input –Densities  
  User Input -  Zs  
AGA3 1985, 
AGA7, AGA9,  
LINEAR  

AGA8 1985 HV-GR-CO2 The Gravity, Heating Value, Carbon 
Dioxide Method 

METERS  GR-CO2-N2 The Gravity, Carbon Dioxide, 
Nitrogen Method 

  Gas Analysis Primary, Compositional Analysis 
Method 

  HV-GR-CO2-N2 The Gravity, Heating Value, Carbon 
Dioxide, Nitrogen Method 

  HV-CO2-N2 The Heating Value, Carbon Dioxide, 
Nitrogen Method 

  GR-CH4-CO2-N2 The Gravity, Methane, Carbon 
Dioxide, Nitrogen Method 

 AGA8 1985 (Alternate 
Method) 

HV-GR-CO2 The Gravity, Heating Value, Carbon 
Dioxide Method 

  GR-CO2-N2 The Gravity, Carbon Dioxide, 
Nitrogen Method 

  Gas Analysis Primary, Compositional Analysis 
Method 

  HV-GR-CO2-N2 The Gravity, Heating Value, Carbon 
Dioxide, Nitrogen Method 

  HV-CO2-N2 The Heating Value, Carbon Dioxide, 
Nitrogen Method 

  GR-CH4-CO2-N2 The Gravity, Methane, Carbon 
Dioxide, Nitrogen Method 
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 NX19 1962 GR-CO2-N2 Standard Method 
  Gas Analysis Analysis Method 
  HV-CO2-N2 Heating Value Method 
  GR-CH4-CO2-N2 Methane – Gravity Method 
 User Input User Input – Densities  
  User Input -  Zs  

 

 Among the choices for Super Compressibility for flow rate standard AGA3 1985, the user will 
notice the choice of AGA 8 1985 Alt Meth. The Alternate Method is a non-standard choice. The 
Gross Methods available for gas characterization in AGA Report No. 8 utilize gravity, heating 
value and diluent content to form a pseudo gas composition.  This composition is then used to 
generate the properties of the gas using an equation of state. The Alternate Method makes a check 
to verify that the pseudo composition generated gives back the gravity input and adjusts the 
pseudo composition of the gas to return the input gravity. 

Units 

The US system of units is the initial default units for GOFW2008 and a number of calculation types, such 
as orifice sizing, can be performed only in US units.  For volume flow rate and mass flow rate 
calculations, the System of Units menu includes SI, Metric and IP units in addition to US units. 

Calculation Types 

GOFW2008 supports four different orifice meter calculation types.  They are found under Calculation 
Type on the menu bar. The four Calculation Types (discussed below) are: 

 Volume Flow Rate 

 Mass Flow Rate 

 Differential Pressure 

 Orifice Size 

Volume Flow Rate 

The default orifice meter calculation for GOFW2008 is volumetric flow rate. When this calculation is 
selected, a check mark appears next to Volume Flow Rate on the Calculation Type menu. 
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Summary section 

GOFW2008 ships with default conditions that generate an orifice meter volumetric flow rate calculation. 
A new calculation is made every time an entry changes.  The volume flow rate is returned in the Gas Flow 
Rate field on the Meter Data Tab in standard cubic feet per hour for the default US units. It is also 
displayed in million standard cubic feet per day on the summary section of the As Found and As Left 
Tabs. 

When a value of -1 is returned in the Gas Flow Rate field, an input variable has been entered which is out 
of range or in error.  GOFW2008 indicates the error by highlighting that field in red and returning the 
value of -1 as the Gas Flow Rate.  The input must be corrected for the calculation to proceed. When an 
input variable is outside the normal range but within the calculation limit range, GOFW2008 indicates 
the warning by highlighting that field in yellow (see Appendix A for a complete discussion of 
GOFW2008 warnings and errors).  In the figure below, a temperature of 800°F has been entered 
(maximum temperature in the normal range is 143°F).  In the GOFW2008 program, the temperature 
field is red.  Note the value of -1 in the Gas Flow Rate field. 
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Mass Flow Rate 

To determine mass flow rate, select Mass Flow Rate under the Calculation Type menu. The units in the 
Gas Flow Rate field will change to reflect mass flow rate. The As Found, As Left and Comparison 
Reports will reflect the choice of a mass flow rate calculation. 

 

 

Differential Pressure 

To determine the pressure drop across the orifice plate for a given pipeline configuration and volumetric 
flow rate, under the Calculation Type menu, first Volume Flow Rate and then select Differential Pressure. 
The Gas Flow Rate field becomes an input (enabled) and the Differential Pressure field becomes an 
output (disabled).  A new differential pressure calculation is performed each time a field entry changes. 
The As Found, As Left and Comparison Reports will reflect a differential pressure calculation. 
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 GOFW2008 will only perform Differential Pressure calculations in US units. Additionally “User 
Input” Super Compressibility may not be used for Differential Pressure calculations. 

Orifice Size 

To determine the appropriate orifice size given a volumetric flow rate and assigned differential pressure, 
under the Calculation Type menu, first Volume Flow Rate and then select Orifice Size. The Gas Flow 
Rate field becomes an input (enabled) and the Differential Pressure field becomes an output (disabled). 
An orifice size calculation is made each time a field entry changes. The As Found, As Left and 
Comparison Reports will reflect an orifice size calculation. 

 

 GOFW2008 will only perform Orifice Size calculations in US units. Additionally “User Input” Super 
Compressibility may not be used for Orifice Size calculations. 
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CHAPTER 4

Meter Data Tab 

The Meter Data Tab contains basic meter information necessary to perform a calculation. 
Additionally, it contains gas value information and a calculation error indicator. 

Meter Data 

The Meter Data Tab appears when the GOFW2008 Notebook is opened. There are two pages in the 
Meter Data Tab.  The page can be changed by clicking on the “dog ear” on the current page. Most of the 
information in this tab is self explanatory so only a brief description of the fields is given below. 

 

Flowing Conditions 

The flowing conditions for an orifice plate calculation are Flowing Temperature, Tf, Flowing Pressure, Pf 
and Differential Pressure, hw. The ranges of applicability of the flowing conditions vary depending on the 
standard chosen. A click on the field of entry displays the range of applicability for the flowing condition 
in the statusbar at the bottom of the screen. 
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GOFW2008 allows the use of either absolute pressure or gage pressure for the input flowing 
pressure (GOFW2002 required that the input flowing pressure be given in absolute pressure 
units, not gage pressure).   

 

 Linear Meters 

The Linear Meter Frame appears when AGA7, AGA9 or LINEAR METER is indicated under the “flow 
rate standard” combo box and disappears otherwise. 

Specify the pulse counts, meter factor and k factor. 

The volume through the meter at flowing conditions is calculated with the simple relation: 

Volume at flowing conditions = pulse counts * meter factor / k factor.  

 

The volume at flowing conditions is converted to base conditions using the supercompressibility method 
specified. 

Hardware 

The Hardware section of the Meter Data Tab is used to specify orifice and tube diameter. It outputs the 
ratio of the orifice plate diameter to the tube diameter (commonly known as Beta Ratio).  Since it is 
possible for both diameters to be within the range of the applicable standard, while their ratio is not, the 
Beta Ratio field follows the color formats used to display warnings and errors. 

Gas Value 

The Gas Value is used to indicate the monetary value of the energy unit which is driven by the market. 
Depending on the System of Units used, the Gas Value may be expressed in different units. 

Gas Flow Rate 

The Gas Flow Rate shows the volume in scf/hr flowing through a pipeline. If an error occurs in the 
calculation, the Gas Flow Rate shown is -1. 
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Error Indicator 

When an error or warning occurs in the calculation, a number corresponding to an error or warning 
description will be displayed in the error indicator field (zero indicates no error or warning). The meaning 
of the error indicator can be obtained by positioning the cursor on the error indicator field. The 
error/warning short description will appear in the statusbar. 

Useful Outputs 

The second page of the Meter Data Tab is titled Useful Outputs.  These outputs include the Gas Relative 
Density, the Gross  Heating Value, the Net Heating Value, the Molecular Weight (Molar Mass), the 
Critical Temperature and Critical Pressure (calculated by the Kay‟s rules method) and the Reduced 
Temperature and Reduced Pressure.  

Heating Value 

The Heating Value of the gas is needed to evaluate the economic value of a gas stream. When the full 
composition of the gas is specified, the Heating Value is automatically calculated and displayed in the 
Heating Value field. When a Gross Method or User Input gas characterization is used, GOFW2008 
outputs -1 for the Heating Value of the gas indicating that the Heating Value has not been calculated. The 
-1 output as well as any other gross heating value output from GOFW2008 can be overwritten if the 
actual gross heating value of the gas is known. Simply check the HV Overwrite check box and input the 
desired value which will then be used for the economic evaluation performed by GOFW2008 for As 
Found and/or As Left (but not for the comparison screen or Comparison Report. 
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CHAPTER 5

Type and Materials Tab 

The Type and Materials Tab is used to specify the configuration of  the orifice meter and the materials 
used in pipeline and orifice plate manufacture.  

Type and Materials 

Type and Materials can be accessed by clicking on the Type and Materials Tab of the GOFW2008 
Notebook. 

Type of Taps 

There are two types of taps supported in AGA Report No. 3, flange and pipe taps. Cases of mixed taps 
are not supported by GOFW2008.  Select calculations for Flange or Pipe Taps by clicking on the option 
button desired. 

Location of Tap for Measurement of Flowing Pressure 

Specify whether the flowing pressure tap is located before the orifice plate (upstream) or after the orifice 
plate (downstream). 
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Tube Material 

Tube material must be specified to account for thermal expansion of the tube at different temperatures 
since metals have different thermal expansion coefficients. Three materials are specified in AGA Report 
No. 3 (1985 and 1992).   

 Carbon Steel 

 Monel 

 Stainless Steel 

Carbon steel is the default tube material since it is most commonly used in orifice meter installations. 
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Meter Tube Diameter Measurement Temperature, Tr 

The Meter Tube Diameter Measurement Temperature refers to the tube temperature when the tube 
diameter was measured. When a tube diameter is given, a temperature must accompany it since the 
diameter is sensitive to temperature changes. A default temperature of 68°F is given. 

Orifice Material 

Orifice material must be specified to account for thermal expansion of the orifice at different 
temperatures since metals have different thermal expansion coefficients. Three materials are specified in 
AGA 3 (1992) and two in AGA 3 (1985). 

 Stainless Steel 

 Monel 

 Carbon Steel * 

* Carbon Steel as orifice material is not supported in AGA Report No.3, 1985. If the user selects Carbon 
Steel with AGA3 1985 as the flow rate standard, the program will issue a warning and change the 
selection to Stainless Steel. If Carbon Steel has been selected and the user changes the flow rate standard 
to AGA 3 1985, GOFW2008 will change the Carbon Steel selection to Stainless Steel without issuing a 
warning. 

Stainless steel is the default orifice material since it is most commonly used for orifice plates. 

Orifice Diameter Measurement Temperature, Tr 

The Orifice Diameter Measurement Temperature refers to the orifice temperature when the orifice 
diameter was measured. When an orifice diameter is given, a temperature must accompany it since the 
diameter is sensitive to temperature changes. A default temperature of 68°F is given. 
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CHAPTER 6 

Gas Characterization Tab 

The Gas Characterization Tab is used to specify the composition of  the gas or the means to 
characterize its physical properties. 

Gas Characterization 

The Gas Characterization Tab changes according to the Gas Characterization option chosen on the left 
side of the GOFW2008 Notebook. 

Gas Analysis 

The Gas Analysis screen is used when the full compositional analysis of the gas mixture is known. The 
Gas Analysis screen is displayed on the Gas Characterization Tab when the Gas Analysis option is chosen 
under Gas Characterization on the left side of the Notebook. 

 

The Gas Analysis screen permits the user to enter values for 21 components. However, when the Gas 
Analysis Method under AGA8 1985 or NX19 1962 is used argon is excluded. 
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The Cal. w/Fracts. in error Checkbox 

A check in the Cal. w/Fracts. in error  (calculate with fractions in error) checkbox allows computations 
to be performed even if the mole percent of a gas component is outside the range recommended for 
some standards.  For example, AGA Report No. 8 was developed and tested within certain limits.  The 
accuracy of calculations made with components outside the tested range cannot be assured.  If, however, 
a computation is required under these circumstances, the Cal. w/Fracts. in error checkbox prevents 
GOFW2008 from checking fractions and allows the calculation to proceed.  Since the numbers entered 
are outside the tested limit, an unexpected math error may occur.  The user is cautioned that the use of 
this override is not in conformance with the limits of the standards and therefore this override is not 
recommended. 

The Normalize Mole % Button 

A useful feature of the Gas Analysis Method is the Normalize Mole % button. When the user input mole 
percentages are very close to 100% this button can be clicked to normalize all component percentages so 
that they equal 100. 

Other Features 

Other features of the Gas Analysis input screen include the Mole % Sum and the  Diff labels. They 
assist the user in assessing the deviation of the total of the input mole percentages from 100%.  

The Gas Analysis input screen carries a summation of butanes, pentanes and hexane+ percentages.  It is 
possible for individual percentages to be within the accepted range while their sum is not.  For example, if 
AGA Report No. 8 is used to characterize a gas with 3.5% n-butane and 3.5% i-butane, the individual 
components are within the allowed range but their sum is not. GOFW2008 indicates the error by 
displaying the Butanes summation label in red. 

Gross Methods 

Gross Methods include all the characterization methods that use a combination of Specific Gravity, 
Heating Value, Mole Percent of Nitrogen, Carbon Dioxide, Methane, Hydrogen and Carbon Monoxide.  

Gross Methods in GOFW2008 are those which are characterized neither as Gas Analysis Methods nor as 
User Input Methods. An example of a Gross Method is the Gross Characterization Method 2 in AGA 
Report No. 8 (1992).  
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User Input Method 

A gas can also be characterized directly in GOFW2008 by specifying the gas densities at base and 
standard conditions or by specifying the compressibility factor of the gas at base and standard conditions 
and the gas relative density. These are equivalent since, if the temperature and pressure of the gas are 
known, having the density at base and flowing conditions allows one to calculate the compressibility 
factor at base and flowing conditions as well as the gas relative density at base conditions. Nevertheless, 
either screen may be used to input known properties. 

 

.   
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CHAPTER 7 

Default Tab 

Default Quantities 

The Default Configuration Tab in the GOFW2008 Notebook has three pages. The user can change the 
page by clicking on the “dog ear” on the current page. Page 1 of the Default Tab is used to configure 
default temperatures and pressures. 

Reference Conditions 

 The various reference temperatures and pressures include the following: 

 The contract temperature and pressure or base conditions (Tb, Pb) 

 The reference temperature and pressure for relative density (specific gravity) (Tgr,Pgr) 

 The reference temperature and pressure for the mass (and molar) heating value, the reference 
temperature and pressure of gas combustion (Th, Ph) 

 The reference temperature and pressure for gas calorimetric density (Td, Pd). Td  and Pd is used for 
conversion of mass (or molar) heating value to volumetric heating value, the gas density used for 
calorimeter/heating value calculations. 
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Appendix C of AGA Report No. 8 (1992) can be consulted for a detailed discussion of reference 
conditions.  The default reference temperatures of 60°F and reference pressures of 14.73 psia are 
commonly used in the U.S. gas industry. 

The contract pressure and temperature (Pb  and Tb) are used for all standard options to calculate the gas 
volume flow rate at base conditions. However, all other reference pressures and temperatures are only 
used when AGA Report No. 3 (1992) is combined with AGA Report No. 8 (1992) and in other 
standards‟ combinations that include a full gas composition analysis. 

Mercury (Hg) Manometer 

Page 2 of the Default Tab, Mercury (Hg) Manometer, is needed only if a mercury manometer is used to 
measure the differential pressure.  If a mercury manometer is used, then the calculation of the factors 
Fhgm, Fhgl and  Fhgt require: 

 The temperature of the mercury when the manometer was calibrated. 

 The meter ambient temperature. 

 The gravitational acceleration at the meter location. 
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The gravitational acceleration can be either input or calculated. If calculated, the required quantities are 
the meter latitude and the meter elevation above sea level (the elevation is negative below sea level). The 
default values are 60°F for the mercury temperature when the manometer was calibrated, 60°F for the 
meter ambient temperature, the input option (not the calculate option) for the gravitational acceleration at 

the meter location and 32.174 ft/sec
2 

for the gravitational acceleration. If the calculate option is used for 
the gravitational acceleration at the meter location, the meter latitude and elevation can be revised from 

the default values 0.0 feet and 45 degrees. 

The alternative values are the actual conditions. 

Other Properties 

Page 3 of the Default Tab, Other Properties, is available when the flow rate standard is AGA Report No. 
3 (1992). The defaults are the following conditions: 

 A natural gas absolute viscosity at flowing conditions, Tf and Pf of 0.0102680 cP 

 A natural gas isentropic exponent, k of 1.3. 

Alternatives are the following conditions: 

 The natural gas viscosity at flowing conditions 

 The natural gas isentropic exponent. 
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Section 3.4.5 of AGA Report No. 3 (1992) notes that the default value for viscosity is an average value for 
natural gases with relative density from 0.55 to 0.75 in the temperature range from 30 to 90°F.  For gases 
with viscosity outside the range 5.9E-6 to 7.9E-6 pounds mass per foot-second and/or flow outside the 
above ranges, particularly at low Reynolds numbers, the default value should be replaced by a more 
accurate gas viscosity input value. 

Discussion in Section 3.4.6.1 of AGA Report No. 3 (1992) states that for many applications, the real 
compressible fluid isentropic exponent is nearly identical to the ideal gas isentropic exponent. This is 
nearly identical to the perfect gas isentropic exponent, and accepted practice for natural gas applications is 
to use 1.3 for the isentropic exponent. For gases with isentropic exponents significantly different from 1.3, 
the default should be replaced with a more accurate value. 

How To Change the Default Configuration 

GOFW2008 uses the file GOFW2008.ini for the default configuration. This file is placed in the 
subdirectory in which you install the software.  The format of GOFW2008.ini is the same as the .CS1 
files.  If you prefer a different set of default values when you run GOFW2008, simply edit a GOFW2008 
file to the desired defaults and save it. Then, in Windows Explorer, rename the saved .CS1 file to 
GOFW2008.ini and replace the original GOFW2008.ini file. 
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CHAPTER 8 

Instrument Calibration Correction Factors 

Tab 

Instrument Calibration  

The Instrument Calibration Tab is used if instrument calibration is required. The default for GOFW2008 
is not to use instrument calibration corrections. 

 Four different instrument calibration options are provided 

 Static pressure instrument calibration with a deadweight calibrator 

 Differential pressure instrument calibration with a deadweight calibrator 

 Differential pressure instrument calibration using a water manometer (with air in both manometer 
legs) 

 User Input calibration factor (to allow for alternative calibration techniques). Calculations of factors 
are made using methods in the 1985 and 1992 AGA Reports No. 3. 

Static Pressure Deadweight Calibrator 

Page 1 of the Inst. Calib. Tab contains entries for the Static Pressure Dead Weight Calibrator. 
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Select Yes for the DWT (Dead Weight) Calibration Correction if static pressure instrument adjustment 
with a calibration factor is required and the static pressure sensor was calibrated with a deadweight 
calibrator. The weights used for most calibrators are based on the default value of the gravitational 
acceleration at 45 degrees latitude and sea level, that is the standard acceleration of gravity, 32.17405 
ft/sec2. If the weights are based on a gravitational acceleration different from 32.17405 ft/sec2 it should 
be input. The option is provided to either input or calculate  the gravitational acceleration at the location 
where the static pressure measurement was calibrated (usually the meter location). If the input option is 
used, the default will be replaced by the input value. If the calculate option is used, the location (latitude 
and elevation) where the static pressure measurement instrument was calibrated is required. 

Water Manometer Calibration Correction 

Page 2 of the Inst. Calib. Tab contains entries for the Water Manometer Calibrator. 
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Select Yes for the Water Manometer Correction if differential pressure instrument adjustment with a 
water manometer is required and the differential pressure sensor was calibrated with a water manometer.  
Quantities required for the calculation of correction factors are the water temperature when calibrated, the 
air temperature when calibrated (using air in both legs of the water manometer), and the elevation and 
gravitational acceleration at the location of calibration of the differential pressure instrument.  

The option is provided to input or to calculate  the gravitational acceleration at the location of the 
calibration of the differential pressure instrument.  If the input option is used, the default value will be 
replaced by the input value. If the calculated value is used, the location (latitude and elevation) where the 
differential pressure instrument was calibrated using the water manometer are required (the elevation is 
required in every case in which water manometer correction factors are used). 

Differential Pressure Dead Weight Calibrator 

Page 3 of the Inst. Calib. Tab contains entries for the Differential Pressure Dead Weight Calibrator. 



G O F W 2 0 0 8 V 1 . 0  

 

 40 

 

Select Yes for the DWT (Dead Weight) Calibration Correction if differential pressure instrument 
adjustment with a calibration factor is required and the differential pressure sensor was calibrated with a 
deadweight calibrator. The weights used for most calibrators are based on the default value of the 
gravitational acceleration at 45 degrees latitude and sea level, that is the standard acceleration of gravity, 
32.17405 ft/sec2. If the weights are based on a gravitational acceleration different from 32.17405 ft/sec2 , 
it should be input. The option is provided to either input or calculate  the gravitational acceleration at the 
location where the static pressure measurement was calibrated (usually the meter location). If the 
gravitational acceleration at the location of the calibration is input, the default will be replaced by the input 
value. If the calculate option is used for the gravitational acceleration, the location (latitude and elevation) 
where the differential pressure measurement instrument was calibrated is required. 

User Input Calibration Factor 

Page 4 of the Inst. Calib. Tab contains the User Input Calibration Factor.  

The User Input calibration factor is needed only in unusual situations where a factor not provided by 
other options in GOFW2008 is required. One example is the measurement of the differential pressure 
using a manometer other than a mercury manometer. Another example is the use of a prover to calibrate 
the orifice meter. In any case, the user is cautioned that any value other than the default value of 1.0 for 
the user input calibration factor will change the calculated meter flow rate proportional to the user input 
calibration factor. 
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Appendix A 

Warnings and Errors 

Introduction 

 

This appendix discusses warnings and errors which can be encountered when running the GOFW2008 
program for orifice meter calculations.  Each warning or error has a number (positive for warnings and 
negative for errors) and a one-line message associated with it.  Numbers  are shown in the error 
indicator field located in the Meter Data Tab and one-line messages are shown on the statusbar. 
 
GOFW2008 displays input errors by highlighting the relevant field in red.  The calculation cannot be 
made until the error is corrected. An error is encountered if (1) the user attempts to make an invalid 
program selection, (2) an input quantity is outside the calculation limit range of the selected calculation 
method or (3) the resultant calculation encounters an instance where the calculation is not valid. 
 
GOFW2008 displays input warnings by highlighting the relevant field in yellow.  If a warning is 
encountered, the calculation is allowed to continue..  A warning occurs when (1) an input quantity is 
outside the normal range but inside the calculation limit range or (2) the calculated value is outside the 
tested limits of the correlation used.  For a more detailed discussion of the normal and calculation limit 
ranges, refer to the referenced technical documentation listed in the following sections. 

 

GOFW2008  Program Selection Errors, Input Quantity Warnings and Errors and 

Calculation Warnings and Errors 

GOFW2008 warnings and errors can be divided into two categories shown in Table A-1: 

Table A-1 

Warning and Error Categories 

 

Number Description 

110-128 Input Quantity Warning or Error 

129-138 Calculation Warning or Error 

 

An input quantity error occurs when an input is outside the calculation limit range (outside the 
acceptable or tested limits for the selected method). An input quantity warning occurs when an input is 
outside the normal range.  This occurs when the input quantity is outside the specified range as defined 
by AGA Report No. 8 (1992), where the compressibility factor is within a 0.1% average uncertainty, or 
outside the specified range of AGA Report No 8 (1985), or outside the specified range of the 1962 
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NX-19 Standard; (2) outside the specified range as defined by ISO/CD 12213, Part 3, 1994 Draft, 
where the calculated compressibility factor is within a 0.1% average uncertainty (for OPTION 1) or (3) 
outside the specified range of AGA Report No. 3, Part 3 (1992) standard or the AGA Report No 3. 

A calculation warning occurs if during the calculation an abnormal situation is encountered in which 
the resultant calculated values are outside the tested limits of the method.  A calculation error occurs if, 
during the calculation, an abnormal situation is encountered in which the resultant calculated values are 
known to be incorrect.  

Numbers and one-line messages for warnings and errors are listed in Table A-2.  Table A-3 provides a 
detailed description of the warnings and errors. 

Table A-2 

GOFW2008 Warnings and Errors 

 

Warning or Error Number One-Line Message 

-109 Instrument Factor Input out of range 

-110 User Input Calibration Factor out of range 

+111 Flowing Pressure in expanded range 

-111 Flowing Pressure out of range 

+112 Flowing Temperature in expanded range 

-112 Flowing Temperature out of range 

+113 Heating Value in expanded range 

-113 Heating Value out of range 

+114 Relative Density in expanded range 

-114 Relative Density out of range 

+115 A Component Mole % in expanded range 

-115 A Component Mole % out of range 

+116 Sum of Comp. Mole %'s <99.99 or >100.01 

-116 Sum of Component Mole %'s out of range 

-117 User Input of Density out of range 

-118 User Input of Z Factor out of range 

-119 Reference Temperature out of range 

-120 Reference Pressure out of range 

+121 Meter Tube Diameter less than 2.0 inches 

-121 Meter Tube Diameter out of range 

+122 Orifice Diameter less than 0.45 inches 

-122 Orifice Diameter out of range 

+123 Diameter Measurement Temperature not 68 Deg.F 

-123 Diameter Measurement Temperature out of range 

+124 Beta Ratio < 0.1 or > 0.75 
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Warning or Error Number One-Line Message 

-124 Beta Ratio out of range 

-125 Differential Pressure out of range 

-126 Gas Viscosity out of range 

-127 Isentropic Exponent out of range 

-128 Gas Flowrate out of range 

-129 Density Root out of range 

-130 DGROSS iterations out of range 

-131 VIRGS Calculation out of range 

-132 Pressure Derivative out of range 

+133 Density in BRAKET out of range 

-134 No. of BRAKET iterations out of range 

-135 No. of DDETAIL iterations out of range 

+136 Reynolds Number out of range 

-137 Gr, HV and CO2 not consistent 

-138 VIRGS term out of range 
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Table A-3 

Input Quantity Warnings and Errors 

Reference Symbol Actual Reference 

8 AGA Report No. 8 (July 1994 Printing) 

3 AGA Report No. 3, Part 3 (1992) 

I ISO/DIS 12213-3, 1994 Draft 

 

 

Warning 
or Error 
Number 

Input Quantity Input Quantity 
Reference Ref-Pg-
Eq 

Standard Option and Gas 
Analysis Method 

Warning (+) 
or Error (-) 

Input Quantity 
Acceptable Range 

Input Quantity 
Range Reference 
Ref-Pg 

110 User Cal. Factor  All Standards (-) 0 < Fu  

111 Pressure (psia) 3-5-(3-2) AGA8‟92 -AGA3‟92 Gr-
HV-CO2 

(+) 0 < Pf <= 1200 8-7 

   AGA8‟92 Gr-N2-CO2 (-)  0 < Pf <= 1740 I-7 

   AGA8‟92 

Full Gas 

Analysis 

(+)  0 < Pf <= 1750 8-6 

    (-)  0 < Pf <= 40000 8-3 

   User Input (-)  0 < Pf <= 40000  

   AGA3 „85 - NX19 „62 

All Methods 

(+) 0 < Pf <= 5014.7  

    (-) 0 < Pf  

   AGA3 „85 AGA8 „85 

All Methods 

(+) 0 < Pf <= 20000  

    (-) 0 < Pf  

112 Temperature (Deg 
F) 

3-5-(3-2) AGA8‟92 -AGA3‟92 Gr-
HV-CO2 

(+) 32 <= Tf <= 130 8-7 

   AGA8‟92 -AGA3‟92 Gr-
N2-CO2 

(-) 14 <= Tf <= 149 I-7 

   AGA8‟92 -AGA3‟92 

Full Gas 

Analysis 

(+) 17 <= Tf <= 143 8-6 
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Warning 
or Error 
Number 

Input Quantity Input Quantity 
Reference Ref-Pg-
Eq 

Standard Option and Gas 
Analysis Method 

Warning (+) 
or Error (-) 

Input Quantity 
Acceptable Range 

Input Quantity 
Range Reference 
Ref-Pg 

    (-) -200 <= Tf <= 760 8-3 

   User Input (-) -200 <= Tf <= 760  

   AGA3 „85 - NX19 „62 

All Methods 

(+) -40 <= Tf <= 240  

   AGA3 „85 AGA8 „85 

All Methods 

(+) -200 <= Tf <= 400  

113 Heating Value 
(Btu/ft^3) 

8-142-(C.5-1) AGA8‟92 -AGA3‟92 

Gr-HV-CO2 

(+) 805 <= HV <= 1208 I-7 

    (-) 477 <= HV <= 1211 8-3 

   AGA3 „85  All Methods 
with HV 

(-) 0 < HV <=1800  

114 Relative Density 8-132-(C.3-10) AGA8‟92 -AGA3‟92Gr-
HV-CO2 

(+) 0.55 <= Gr <= 0.8 I-9 

   AGA8‟92 -AGA3‟92Gr-
N2-CO2 

(-) 0.55 <= Gr <= 0.87 8-3 

   User Input (-) 0.07 <= Gr <= 1.52 8-3 

   AGA3 „85 - NX19 „62 

All Methods with Gr 

(+) Gr <=0.75  

   AGA3 „85   All Methods 
with Gr 

(-) 0.07 <= Gr <=1.52  

115 Component Mole % 8-29-(25) AGA8‟92 -AGA3‟92Gr-
HV-CO2 

(+) 0 <= CO2 <= 20.0 I-7 

   AGA8‟92 -AGA3‟92Gr-
N2-CO2 

(-) 0 <= CO2 <= 30.0 8-3 

    (+) 0 <= H2 <= 0 8-5 

    (-) 0 <= H2 <= 10.0 I-7 

    (+) 0 <= CO <= 0 8-3 

    (-) 0 <= CO <= 3.0 8-3 

   AGA8‟92 -AGA3‟92Gr-
N2-CO2 

(+) 0 <= N2 <= 20.0 I-8 

    (-) 0 <= N2 <= 50.0 I-9 

  8-17-(12) AGA8‟92 -AGA3‟92Full (+) 0 <= H2O <= 0.05 8-3 
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Warning 
or Error 
Number 

Input Quantity Input Quantity 
Reference Ref-Pg-
Eq 

Standard Option and Gas 
Analysis Method 

Warning (+) 
or Error (-) 

Input Quantity 
Acceptable Range 

Input Quantity 
Range Reference 
Ref-Pg 

Gas 

Analysis 

    (-) 0 <= H2O <= 10.0  

    (+) 0 <= He <= 0.2 8-3 

    (-) 0 <= He <= 3.0 8-3 

    (+) 45.0 <= Meth <= 100.0 8-3 

    (-) 0 <= Meth <= 100.0 8-3 

    (+) 0 <= Ethane <= 10.0 8-3 

    (-) 0 <= Ethane <= 100.0 8-3 

    (+) 0 <= Prop <= 4.0 8-3 

    (-) 0 <= Prop <= 12.0 8-3 

    (+) 0 <= Butanes <= 1.0 8-3 

    (-) 0 <= Butanes <= 6.0 8-3 

    (+) 0 <= Pentanes <= 0.3 8-3 

    (-) 0 <= Pentanes <= 4.0 8-3 

    (+) 0 <= Hexanes + <= 0.2 8-3 

    (-) 0 <= Hexanes + <= 
10.0 

 

    (+) 0 <= O2 <= 0.0 8-3 

    (-) 0 <= O2 <= 21.0 8-3 

    (+) 0 <= CO <= 3.0 8-3 

    (-) 0 <= CO <= 3.0 8-3 

    (+) 0 <= H2 <= 10.0 8-3 

    (-) 0 <= H2 <= 100.0 8-3 

    (+) 0 <= N2 <= 50.0 8-3 

    (-) 0 <= N2 <= 100.0 8-3 

    (+) 0 <= CO2 <= 30.0 8-3 

    (-) 0 <= CO2 <= 100.0 8-3 
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Warning 
or Error 
Number 

Input Quantity Input Quantity 
Reference Ref-Pg-
Eq 

Standard Option and Gas 
Analysis Method 

Warning (+) 
or Error (-) 

Input Quantity 
Acceptable Range 

Input Quantity 
Range Reference 
Ref-Pg 

    (+) 0 <= H2S <= 0.02 8-3 

    (-) 0 <= H2S <= 100.0 8-3 

    (+) 0 <= Argon <= 0.0 8-3 

    (-) 0 <= Argon <= 1.0 8-3 

   AGA3 „85 - NX19 „62 

All Methods with CO2 

(+) 0 <= CO2 <= 15.0  

    (-) 0 <= CO2 <= 100.0  

   AGA3 „85 - NX19 „62 

All Methods with N2 

(+) 0 <= N2 <= 15.0  

    (-) 0 <= N2 <= 100.0  

   AGA3 „85 - NX19 „62 

Full Gas 

Analysis 

(-) 0 <= Any Component 
<= 100.0 

 

   AGA3‟85 

-AGA8‟85 

 All Methods with CO2 

(+) 0 <= CO2 <= 50.0  

    (-) 0 <= CO2 <= 100.0  

   AGA3‟85 

-AGA8‟85 

 All Methods with N2 

(+) 0 <= N2 <= 50.0  

    (-) 0 <= N2 <= 100.0  

   AGA3‟85 

-AGA8‟85 

 Full Gas 

Analysis 

(+) 0 <= H2O <= 1.0  

    (+) 0 <= He <= 1.0  

    (+) 50.0 <= Meth <= 100.0  

    (+) 0 <= Ethane <= 20.0  
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Warning 
or Error 
Number 

Input Quantity Input Quantity 
Reference Ref-Pg-
Eq 

Standard Option and Gas 
Analysis Method 

Warning (+) 
or Error (-) 

Input Quantity 
Acceptable Range 

Input Quantity 
Range Reference 
Ref-Pg 

    (+) 0 <= Prop <= 5.0  

    (+) 0 <= Butanes <= 3.0  

    (+) 0 <= Pentanes <= 2.0  

    (+) 0 <= Hexanes + <= 1.0  

    (+) 0 <= O2 <= 0.0  

    (+) 0 <= CO <= 1.0  

    (+) 0 <= H2 <= 1.0  

    (+) 0 <= N2 <= 50.0  

    (+) 0 <= CO2 <= 50.0  

    (+) 0 <= H2S <= 1.0  

    (-) 0 <= Any Component 
<= 100.0 

 

116 Sum of Mole %'s  Full 

Gas Analysis 

(+) 99.99 <= Sum <= 
100.01 

 

    (-) 98.0 <= Sum <= 102.0  

117 Densities 3-5-(3-1) User Input (-) 0 < Rho @ Tf & Pf  

 (Lbm/Ft^3) 3-6-(3-4a)  (-) 0 < Rho @ Tb & Pb  

118 Z Factors 3-5-(3-2) User Input (-) 0 < Z @ Tf & Pf  

  3-7-(3-7)  (-) 0 < Z @ Tb & Pb  

119 Reference Temp. 8-11-(7)  (-) 32.0 <= Tb <= 77.0 8-143 

 (Deg. F) 8-12-(9)  (-) 32.0 <= Tgr <= 77.0 8-143 

  8-136-(C.4-5)  (-) 32.0 <= Th <= 77.0 8-143 

  8-142-(C.5-1)  (-) 32.0 <= Td <= 77.0 8-143 

120 Reference Press. 8-11-(7)  (-) 13.0 <= Pb <= 16.0 8-143 

 (psia) 8-12-(9)  (-) 13.0 <= Pgr <= 16.0 8-143 

  8-142-(C.5-1)  (-) 13.0 <= Pd <= 16.0 8-143 

121 Pipe Diameter 3-8-(3-10)  (+) 2.0 <= Dr 3-9 

 (inches)   (-) 0.0 < Dr < 100.0  
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Warning 
or Error 
Number 

Input Quantity Input Quantity 
Reference Ref-Pg-
Eq 

Standard Option and Gas 
Analysis Method 

Warning (+) 
or Error (-) 

Input Quantity 
Acceptable Range 

Input Quantity 
Range Reference 
Ref-Pg 

122 Orifice Diameter 3-8-(3-9)  (+) 0.45 <= dr 3-9 

 (inches)   (-) 0 < dr < 100.0  

123 Measurement Temp. 3-8-(3-10)  (+) Tr not equal 68 Deg. F  

124 BETA Ratio 3-8-(3-8)  (+) 0.1 <= dr/Dr <= 0.75 3-9 

    (-) 0 < dr/Dr < 1.0  

125 Differential Press. 
(inches H2O) 

3-12-(3-30)  (-) 0 < hw  

126 Gas Viscosity 3-10-(3-23) AGA3‟92AGA8‟92Gr-
Hv/N2-CO2 

(-) 0.01 <= Visc <= 0.1  

 (Centipoise)  AGA3‟92AGA8‟92Detail
/User 

(-) 0.005 <= Visc <= 0.5  

127 Isentropic Exp. 3-12-(3-32) AGA3‟92AGA8‟92 (-) 1.0 < k < 2.0  

 

 

  

 

Table A-4 

Calculation Warnings and Errors 

 

Warning or  
Error Number 

Description 

-129 Density search failed. A default density might be used. The compressibility factor calculation cannot be made. 

-130 No convergence in density search for gross methods.  The compressibility factor calculation cannot be made. 

-131 Gross Method Error: Attempt to take the square root of a negative number.  The compressibility factor calculation cannot be 
made. 

-132 Detail Method Error: Pressure has a negative density derivative.  Default gas density used.  One cause of this error is that the 
system may contain liquid. 

133 Detail Method Warning: Density found exceeded maximum allowable density.  Default procedure used. 

-134 Detail Method Error: Maximum number of iterations in to find density exceeded.  Default density used. 

-135 Detail Method Error: Maximum number of iterations in Density Search exceeded. 

136 Flowrate Calculation Warning: Reynolds number is less than 4000. 

-137 Gross Method Error: Combined value of gas relative density (Gr), heating value (HV) and mole % CO2 are not consistent.  This 
error is encountered when these three values entered are not consistent or realistic.  The compressibility factor cannot be 
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Warning or  
Error Number 

Description 

calculated. 

-138 Gross Method Error: Invalid term.  The compressibility factor cannot be calculated. 
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Appendix B

Methods for comparing GOFW2008 Calculations with GPA-

2172, ISO 6976 and Other Standards 

INTRODUCTION 

 
This appendix provides information on how to compare GOFW2008 calculations which use the gas 
composition analysis in the AGA Report No. 8 (1992) DETAIL CHARACTERIZATION 
METHOD with calculations using other standards.  Relative density and heating value from natural 
gas composition calculated using GPA 2172 and ISO 6976 are particularly pertinent because of their 
wide use.  The titles of these standards are GPA-2172, "Calculation of Gross Heating Value, Relative 
Density and Compressibility Factor for Natural Gas Mixtures from Compositional Analysis," and ISO 
6976, "Natural Gas - Calculation of Calorific Value, Density, Relative Density and Wobbe Index 
Composition."  The 1992 AGA Report No. 8 (1994 reprint) can be consulted as the basis for the 
equations below. 

RELATIVE DENSITY 

The molar density d of a natural gas is calculated from the natural gas composition using differing 
equations in AGA Report No. 8, GPA-2172 and ISO 6976.  For this reason there are small differences 
in the calculated values of Zgr, the compressibility factor at the relative density reference condition Tgr 
and Pgr.  For equal values of reference temperature and pressure, the relationship of the relative density 
Gr

* for a given standard to the relative density Gr from AGA Report No. 8 is  
 

Gr
*  =  (Zgr / Zgr

* ) Gr 
 
where Zgr is the compressibility factor from AGA Report No. 8 and Zgr

* is the compressibility factor 
from the given standard.  For most dry natural gases, the ratio (Zgr/Zgr

*) usually differs from unity by 
less than 100 parts per million. 
 

HEATING VALUE 

 
The relationship of the volumetric gross heating value HV* for a given standard to the volumetric gross 
heating value HV from AGA Report No. 8 is 
 

HV* = (Zd / Zd*) (HN*
ideal / HNideal) HV 

 
In this equation Zd is the compressibility factor at Td, Pd , and HNideal is the molar ideal gas gross 
heating value at Th, Ph.  AGA Report No. 8, Appendix C can be consulted for discussion of the 
reference temperatures and pressures Th, Ph, Td and Pd.  The molar ideal gas gross heating value HNideal 
is related to the volumetric gross heating value HV by the relation 
 

HNideal = (Zd R Td / Pd) HV 
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where R is the universal gas constant. 

FLOWRATE 

The volume flowrate Qb referenced to base conditions Tb, Pb is equal to the mass flowrate Qm divided 
by the mass density rb at the base conditions Tb, Pb.  The mass density at base conditions rb is 
 

rb = (Pb Mr / Zb R Tb) 
 
where Mr is the molar mass (molecular weight) of the gas and R is the universal gas constant.  The 
relationship of Qb to Qm is therefore 
 

Qm = (Pb Mr / Zb R Tb) Qb 
 
The relationship of the flowrate Qb

* referenced to a given standard for which Zb
* is the 

compressibility factor at Tb
*, Pb

* to the flowrate Qb referenced to AGA Report No. 8 for which Zb is 
the compressibility factor at Tb, Pb is 
 

Qb
* = Qb (Pb / Pb

*) (Tb
* / Tb) (Zb

* / Zb) 
 
If Tb

* = Tb and Pb
* = Pb then 

 
Qb

* = (Zb
* / Zb) Qb 

 
As an example of the use of this ratio, consider a case in which GOFW2008 is to be used to check 
calculations from an electronic flow meter using the 1992 AGA Report No. 3 orifice meter calculations 
methods, the AGA Report No. 8 method for gas density at flowing conditions and the GPA-2172 
methods for the relative density and the compressibility factor at base conditions.  In this instance, the 
EFM calculation can be verified using GOFW2008 by performing the flowrate calculation using the 
gas analysis as input to obtain (Qb)GOFW2008.  Then the following calculation can be made for Qb

*  
 

Qb
* = (Qb)GOFW2008 (Zb)GPA-2172 / (Zb)GOFW2008 

 

where (Zb)GOFW2008 is the value of Zb from GOFW2008 and (Zb)GPA-2172 is the value of Zb from GPA-
2172 (both at the same base temperature and same base pressure).  The value of Qb

* then can be 
compared with the volume flowrate (Qb)EFM calculated by the electronic flow meter.  Agreement 
between (Qb)EFM and Qb

* should be achieved at a specified level for EFM verification purposes.  
Disagreement greater than 50 parts per million would not be expected if the electronic flow meter is 
correctly programmed. 
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